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AR Collections Manager Overview 
 

The AR Collections Manager module maintains the customer's collection status notes, promotes actions by credit 
assistants and generates collection communication.   

Stop searching for information—and start using it.  

• AR Collections Manager can give you all the collections-related information you need. 

Save time and money.  

• AR Collections Manager can automate some of your time-consuming collection activities. 

Get Results. 

• You can easily create and send powerful overdue notices that get your customers to act. 
• Reprint invoices “on the fly”. 
• eMail Clients directly from Solomon. 
• Historically track Contacts. 
• Schedule "To Do’s" and reminders. 
• Create template documents including letters and emails.  
• Record an email was sent, a letter was printed, or invoices were printed. 
• Write-off uncollectible invoices. 

Product Specifications 
For purposes of this documentation, Microsoft Dynamics™ SL refers to Solomon v6.0 and Microsoft Dynamics™ SL 
v6.5. Microsoft Dynamics is a trademark of Microsoft Corporation in the United States and/or other countries. 

These instructions should only be implemented by users or resellers who are skilled in applying Microsoft 
Dynamics™ SL updates. Please consult your reseller if you need assistance. 

 

Product Type 

• Microsoft Dynamics™ SL VB Tools Developed Application 
• Customization Manager Enabled 

Technical Requirements 
• Standard Microsoft Dynamics™ SL Environment 

Supported Versions 
• Solomon 6.0, Microsoft Dynamics™ SL 6.5 

Module Compatibility 

• Requires Microsoft Dynamics™ SL Accounts Receivable Module 
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• Compatible with (but not required) Microsoft Dynamics™ SL Order Management, Flexible Billings, Currency 
Manager and Multi-Company Module. 

Supported Databases and Operating Systems 

Database 
Microsoft SQL Server 2000 SP3, SP3a, SP4, 2005 

Note: This product will require a license key if you are installing the product to a database other than the Solomon 
or Dynamics SL Demo Databases (ie. DemoSolomonSystem and DemoSolomonApp60). 

Server operating systems 
Windows NT Server 4.0 (Service Pack 6a or later) 
Windows 2000 Server  
Windows 2003 Server 

Client operating systems 
Windows NT Workstation 4.0 
Windows NT Server 4.0 TSE and Citrix MetaFrame 1.8 
Windows 2000 Professional 
Windows XP 
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AR Collections Manager Installation 
 

Before You Begin 
 

Back up your system before you install AR Collections Manager.  

Before installing AR Collections Manager, you should make sure that you have a complete backup of your Microsoft 
Dynamics™ SL application software and corresponding databases. 
 
Using Microsoft SQL Enterprise Manager make a back up of all Microsoft Dynamics™ SL Application Databases 
and Microsoft Dynamics™ SL System Databases. 
 
Backup your Microsoft Dynamics™ SL application software using your external tape backup system or other 
appropriate backup utility. This includes all files and directories located in or beneath the Microsoft Dynamics™ SL 
directory.  
 
AR Collections Manager will add customizations to the following screens: 
 
08260 – AR Customer Maintenance 
08262 – AR Shipping Address 
21250 – Shared Information Address Maintenance 
 
Backup any customizations you may have on these screens. 
 
If you currently have AR Collections Manager installed and have customized any AR Collections Manager screens, 
reports, or PVs, you will need to back them up and reinstall them once you have completed the AR Collections 
Manager installation process. 
 

Information you will need to know 
Before proceeding you will need to determine the location of your application software installation (For 
example….c:\Program Files\Solomon\....).  The AR Collections setup wizard will attempt to search for the 
installation path and will allow you to modify this information if necessary. 
 
AR Collections Manager will need to know the Microsoft SQL Server ‘sa’ user password in order to update the 
appropriate tables in your SQL Database.  Please consult your system administrator to obtain this information 
before proceeding with the AR Collections Manager installation. 
 
AR Collections Manager will also need to know the name of your Microsoft SQL Server and  Microsoft Dynamics™ 
SL System database.  This information may be obtained from the Microsoft Dynamics™ SL login screen by clicking 
on the System Database button to display the name of your Microsoft SQL Server and corresponding Microsoft 
Dynamics™ SL System Database 
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AR Collections Manager will also need to know the name of your Microsoft Dynamics™ SL application database.  
This information may be obtained by logging into Microsoft Dynamics™ SL and selecting Utility/Company 
Maintenance from the Microsoft Dynamics™ SL Menu bar. 

 

 

 

 

If you are upgrading your version of AR Collections Manager, you will also need to know the location of the 
setup.exe file from you current installation of AR Collections Manager. This may be located in c:\AR Collections 
Manager. You will need this to uninstall the current version of AR Collections Manager. Please note, no data will be 
lost during the uninstall.  
 
Note: This product will require a license key if you are installing the product to a database other than the Solomon 
or Dynamics SL Demo Databases (ie. DemoSolomonSystem and DemoSolomonApp60). 
 
Once you have obtained the above information you can proceed with the install. 
 

Type of AR Collections Manager Installation 
 

There are different scenarios for installing AR Collections Manager. They are: 
 

1. Installing AR Collections Manager for the first time, or upgrading AR Collections Manager. Refer to the 
section Installing AR Collections Manager on your Server. 

2. Installing AR Collections Manager for additional application databases. Refer to the section Installing AR 
Collections Manager to additional databases. 

3. Reinstalling AR Collections Manager. Refer to the section Reinstalling AR Collections Manager. 
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Installing AR Collections Manager on Your Server 
 
 
Remove your current version of AR Collections Manager 
 
If you are installing an upgrade you will need to uninstall the current version. Run the setup.exe application for your 
current version of AR Collections Manager. You will be prompted with the following screen. Select Remove and 
click Next. 
 

 
 
You will be prompted to remove the product. Click Ok to continue or Cancel to stop the remove process. If you click 
cancel you will need to rerun the setup.exe again from the beginning. 
 

 
 
Once the remove has been completed, you will be prompted with the Finish screen. Click Finish. 
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Installing AR Collections Manager 
 
Create a Subdirectory to hold the installation files.  i.e. C:\AR Collections Manager.  Copy the zip file received from 
SSYH into this Subdirectory. 

 
Launch the Zip file and extract the files into the same Subdirectory.  
Launch Setup.exe and follow the Install Shield steps. Click Next 
when presented with the AR Collections Manager welcome screen. 

 
 
Review the 
license 
agreement and 
click Yes if you 
wish to 
continue with 
the installation 
process. 
 

 
 

 
 
 
You will be prompted for the installation path where your Microsoft 
Dynamics™ SL applications presently reside.  If necessary, click 
the Browse button to change or modify the destination directory.  
The proper installation directory should be the Microsoft 
Dynamics™ SL root directory similar to that displayed below. 
Once the default directory is correct click Next to continue with the 
installation process. 
 
 
 
 

 
You will be prompted with the following message: 
Click Yes to install the database objects. If you are upgrading from a prior version of AR Collections Manager, you 
must click Yes to this question. No data from your existing AR Collections Manager application will be lost. 
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Next you will be prompted to review the installation 
parameters and continue with the installation.  To begin 
the installation click Next. To go back and make a change 
click Back. To cancel the installation click Cancel. 
 
 
 
 
 
 
 
 
 

 
 
You will be prompted with 
the following message if you 
are upgrading: 
 
 

Click Ok to continue. If you are upgrading from Solomon 5.x or below, please refer to the section labeled Upgrading 
from Solomon 5.x or below, after you have installed AR Collections Manager. 

 
Once you click OK, the application will be installed and you will 
be prompted for your SQL Server name and password. Once 
you have entered them click Next. 
 
You will be prompted to enter your System and Application 
Databases. Once you have entered them click Next. 
 
 
The application will install the necessary database updates. 

There is no 
message 
displayed 
during this 
process and 
when it is 
completed the 
installation 
complete 
screen will 
display. Click 
Finish. 
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If you upgraded from Solomon 5.x or below please complete the following section labeled Upgrading from Solomon 
5.x or below. Otherwise please continue to the Completing the setup section. 
 

Upgrading from Solomon 5.x or below 
 
The AR Collections Manager application names have changed from Solomon 5.x. You will need to modify the 
delta.mnu to reflect these changes. 
 
Make a backup of your delta.mnu file. 
 
Modify the delta.mnu using the ARPAL.mnu file located in the Solomon\SSYH\AR Collections folder. 
 

Completing the Setup 
Installing the AR Collections Manager Screens using Customization Manager 
 
AR Collections Manager includes modifications to several Microsoft Dynamics™ SL screens in the Accounts 
Receivable module including 0826000 Customer Maintenance, 0826200 Shipping Address, and 2125000 Address 
Maintenance in shared information.  
 
Note: Prior to importing the customizations, make sure you have a backup of any customizations you may have on 

these screens. 
 
To update the screens select Customize\Import 
Customizations from the Microsoft Dynamics™ SL 
Tool Bar and navigate to the SOLOMON\SSYH\AR 
Collections directory.  Highlight 08260.cst, 08262.cst 
and 21250.cst and click Select to add these files to 
the import list. 
  
Note: If you have existing customizations on these 
screens, select the Options Button and select Merge 
for conflict resolution. 
 
When you click Begin Processing the necessary AR 
Collections Manager screen modifications will be 
added to your Microsoft Dynamics™ SL System. 
Once the screens have been added you should 

receive a message indicating that the process has been completed. 
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Adding AR Collections Manager Possible Values (PV) using the Microsoft Dynamics™ SL 
PV Import Utility 
 
Select Utility\Possible Value Import from the Microsoft Dynamics™ SL Tool Bar to begin the PV Import process. 

 
Click the Enter File Name button and 
navigate to the Solomon\SSYH\AR 
Collections directory. Double click on 
ARPALPVREC.CSV file to add the file to 
the import file list. Click Begin 
Processing to update Microsoft 
Dynamics™ SL with the AR Collections 
Manager PV Values. 
 
 
 
 
 

If you are upgrading from a prior version you will receive the following message. Click Yes. 
 

 
 

Unlocking the AR Collections Manager Module  
(This step is not required for Demonstration Purposes.) 

 
Select Utility\SSYH Registration from the Microsoft 
Dynamics™ SL Tool Bar.  Using all upper case letters 
enter ‘ARPAL’ as the module identifier followed by the 
Registration key provided with your software. 
 
 
 
When you save your settings and close the SSYH 
Module Registration screen you should receive a 

message that 
the module has 
been 
successfully 
registered. 
 

 
 
 
 
 
 
Adding Access Rights for AR Collections Manager Screens and Report 
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Select Utility\Access Rights from the Microsoft 
Dynamics™ SL Tool Bar and select the appropriate 
User, Group and/or Company that should receive 
access to the AR Collections Manager screens and 
reports.  Press (F3) in the Screen/Report Number 
field and assign rights to the following AR Collections 
Manager screens and reports. 
 
 
 
 
 

Installing AR Collections Manager to Additional Databases 
 
Once you have installed AR Collections Manager to at least 
one database, you can add the product to additional 
databases. 
 
Run the Microsoft Dynamics™ SL Database Maintenance 
application. Enter the SQL Server Name, Use the ‘sa’ Login 
Id, and enter the ‘sa’ password. 
 
 
 
 
 
 

 
Click on the Browse button to change the Path of 
Configuration File. Browse to the 
SOLOMON\SSYH\ARCollections folder and Open 
Coldbbuild.ini. 
 
Click on the Connect button. Once you are connected to the 
server, the Update Databases tab will be active. Click on the 
Update Databases tab. 
 
 
 
Verify the System Database Name. If it is not correct use the drop down arrow to select the correct database. Click 

on the appropriate database (only select one). If you need 
to add AR Collections Manager to multiple databases, 
please run this process for each database. Click on the 
New Install – Collections Application Tables, Views & 
Procedures. Click on the Update Database button. You will 
receive a message when the process is completed.  
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If you have installed AR Collections Manager to a new System and Application database please follow the section 
labeled Completing the setup. If you have only added AR Collections Manager to a new application database you 
do not need to follow Completing the setup section. 

 

 

 

 

Reinstalling AR Collections Manager 
 
Create a Subdirectory to extract temporary files.  i.e. 
C:\AR Collections Manager.  Copy the zip file 
received from SSYH into this Subdirectory. Launch 
the Zip file and extract the files into the same 
Subdirectory.  Launch Setup.exe and select Repair 
from the InstallShield Wizard screen. Click Next. 
 
 
 
 
 
 
 
 
 
 

 
The AR Collections Manager Install Shield Wizard will reinstall the 
applications. No database updates are performed. Click Finish to exit the 
InstallShield Wizard. You are done with reinstalling AR Collections Manager. 
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AR Collections Manager Application Instructions 

Action Maintenance Screen  

 
 

This screen is used to create, maintain and delete ActionID’s as needed.  Any change to an ActionID will 
only affect future transactions and will not affect/change any transactions already in the system.  The 
ActionID will automatically assign a follow-up date for the customer based on the Business Date in use at 
the time of assignment.  There are four fields on this screen: 
 

1. ActionID:  This is a ten character field (use only numbers and letters). 
2. Description:  A 30 character field to illustrate the Action ID. 
3. Next Contact # Days:  Used to determine the number of days from the current business date 

before the next action is required. 
4. Status: (A) ctive or (I) nactive – Any ActionID marked Inactive will not available for selection. 

AR Collections Manager Setup Screen 

 

The AR Collections Manager Setup Screen names the default ActionID.  The Default Action ID should be 
the most commonly used ActionID.  The purpose it to save the users time by providing them with an action 
(they always have the ability to override the proposed action).  The Default File Path is currently not used.   

User Customer List Screen 
 

Customers can be assigned to a specific Solomon UserID. By assigning customers to a specific Solomon 
user, you are able to maintain a “Ticker List” by CSR.  The AR Collections module, through a combination 
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of the User Customer List Screen and the ActionID Maintenance Screen generate a “Tickler” each time the 
user enters the AR Collections Manager.   

 

 
 

1. User ID: Enter the Solomon user id. Either manually enter the User Id or press F3 and select a User 
Id. 

2. Customer ID:  The customer number as depicted in the AR Customer Maintenance Screen.  Either 
manually enter the Customer Id or press F3 and select a Customer Id. 

3. Customer Name:  This is a read only field displaying the customer name. 
4. The Load All button will assign all customers to the User ID listed at the top.   
5. The Print List button will create and print a listing of all customers assigned to the listed User Id.  A 

complete listing can be generated from the Reports menu. 

AR Collection Contacts Screen 
Use AR Collections Contacts Screen to add and maintain buyer, accounts payable or other contact 
information associated with a customer.  The contact information is referenced by the AR Collections 
Module when generating letters and emails.   
 

 
 
There four (4) Types of contacts maintained in this screen. This screen will create a contact id based on the 
information entered in this screen. Enter a Customer Id, Contact Id (will be created if it does not exist), 
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select type (described below) and enter or press F3 for the Address Id (based on Type selection). If you 
choose the Bill To for Type you are not prompted to enter the Address Id. 

1. Shared Information: The contact information is pulled from the Shared Information module.  In the 
Shared Information module, within Address Maintenance (21.250.00), you can enter and maintain 
address information for a wide range of miscellaneous business addresses.   

2. Bill To:  Information comes directly from the Address Tab - Customer Maintenance Screen 
(08.260.00).    

3. Ship To:   The information is entered in the Accounts Receivable module using the Shipping 
Addresses (08.262.00) screen.   The user can enter the name, address information, and 
telephone/fax numbers for a customer's shipping address.  Each customer is permitted an unlimited 
number of shipping addresses.   

4. Order Management Contact:  Use Customer Contacts (40.370.00) to add and maintain buyers, 
accounts payable contacts or any other contacts within the customers' organizations. These 
contacts can then be referenced by the AR Collections Contacts entering the value or by selecting 
from a possible-values list (F3). 

 
Since each contact type is derived from another Solomon screen, the AR Collections module limits the 
information the user can change on each contact.  User can only change the following fields:  

1. Name,  
2. Attention and 
3. Phone/Ext. 

AR Collections Manager Screen 
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This is the main screen within the AR Collections module. If you have associated a user id with a customer, 
the application will check to see if there are any open worklist items. If there are a message will display 
indicating that you have open items. Click the show worklist button. 

1. Customer Information:  This section determines which CustID the user is working on.  It is 
populated by entering a Customer ID (CustID) in the upper left hand corner. 

a. Contact – Pressing F3 will list all the available contacts set up in the AR Collections 
Module. 

2. Invoice Information:  This section displays the relevant data on Invoice (IN), Credit Memos (CM) 
and Debit Memos (DM) created in the Accounts Receivable (AR), Order Management (OM) or 
Flexible Billings (BI) modules. 

a. Print? – Clicking on the check box will select the document for printing. 
b. Preview Invoices – When in Grid View (F4), clicking on the blank field will change the field 

to a command button. In Form View (F4), the field is shown as a command button. Click on 
the command button to view the invoice. 

c. Write off – Allows small balance write off functionality from the Collections Manger main 
screen.  If selected, the standard Solomon write off function is launched.  The Account and 
Subaccount used for small balance write off is pulled from the AR Setup screen.   

d. Reference Nbr – This is the Invoice or Memo number. 
 



AR Collections Manager for Microsoft Dynamics™ SL User’s Guide       

 

 18

  
 

3. Note/Action Information:  Any note, added through the AR Collections module, is recorded in this 
tab.  The Customer Note (View Only) section will display automatically whenever the user clicks on 
a record.  

a. Notes are added through the Add Note/Act command button. 
b. Every note is assigned an ActionID. 
c. The note can be associated with the client only or associated with a particular document 

(click on Associate with Selected Invoice).  
d. Next Contact Date is auto populated based on the ActionID and the current Business Date.  

The field can be manually overridden, effectively making the contact date a “suggestion” 
only. 

e. Notes added outside this screen will not be recorded by AR Collections. 
f. Note status can be changed from Open to Closed on a per note basis.  Additionally, Action 

items can also be left Open or set to Completed.  Completed items will not display on the 
Worklist. 

 
 

4. View Options:  This tab allows the user to control how notes display, whether to display all Open 
Documents or All Documents and whether to Display MultiCurrency Amounts. 

5. Customer Note (View Only): Displays the selected note from the Note/Action Information tab. 
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6. New Note:  After clicking on the document (i.e. invoice), the user can manually enter their note into 
the field.  The note is added when the user clicks on the Add Note/Act button. 

7. Command Buttons:  There are eight buttons on the screen.  They are as follows: 
a. Cust Mnt – This will open the Customer Maintenance screen. 
b. Contacts – This will open the AR Collections Customer Contact screen. 
c. Show Worklist -  The Work List Screen displays all the actions needing to be competed.  It 

provides the user an Action Description, Action Date & ID,  and Customer.  Whenever the 
user loads the AR Collections Manager screen, if there are any items needing attention, 
the user is prompted with “You have items in your worklist”  command button. 

d. Email Customer – This will open the Document Generation Screen for the user to select 
the email template to use.  Once selected the users’ Microsoft Outlook will open and 
generate an email using the selected template to the email address listed on the contact.  
If the email address is missing, the email is still created but the user has to enter an email 
address.  

e. Edit Note: Click this button to edit the note in the Current Note (View Only) window. Note: 
Users can edit all notes including notes entered by other users. 

f. Refresh Views. Click this to refresh the screen. 
g. Print Invoices – Any invoice or memo that is checked for printing can be generated by 

clicking Print Invoices.  The invoice will also be formatted according to the module that 
created it (i.e.  Flexible Billings Invoices will be formatted differently from AR Invoices). 

h. Open Letter – This will open the Document Generation Screen for the user to select the 
Word template to use.  This will create the Word document for the template selected and 
only for the customer displayed on screen.  It does NOT generate documents for all 
customers. To generate documents to many Customers at a time, please refer to menu 
option “AR Dunning Letters”.    The save as options:  Print and Close – Will print the Word 
Document, write a note to the Collections Manager screen and not save the file/Word 
Document.    Print and Save - Will print the Word Document, write a note to the Collections 
Manager screen and save the file/Word Document.   Draft Mode - Will print the Word 
Document, write a note to the Collections Manager screen and the user has the choice of 
editing the Word Document and then saving or not saving the Word Document. 

 
 

Dunning Letter Generation Screen  
 

 
 

Use this screen to select customers you wish to send a Dunning Letter to.  There are several methods by 
which the selection process can occur: 
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1. Add Customer to List:  In this method, the user enters the customer number into the Customer ID 
field (upper right hand corner) and then clicks Begin Processing.  

2. Select Customers by Balance:  In this method, the user selects one or more criteria (aging or total 
categories) by checking the appropriate box (es).  Next they enter the amount (either negative or 
positive) in the selected box (es).  Select the appropriate Customer Status. Click on Begin 
Processing to select customers. For example the screen above shows All Customers (Customer 
Status All) that have a Total Amount Greater Than or Equal to 1000.  Note: When selecting ‘and’ 
or ‘or’ in the selection criteria you can either have all ‘and’ or all ‘or’ You cannot mix ‘and’ and ‘or’. 

3. Remove All Customers From List: This option will completely remove every customer from the list.  
Click Begin Processing after selecting this option. 

4. Remove Selected Customers:  The user can select (by checking the Remove box next to the 
customer’s name) which customers to remove from the list.  Once the selections have been made, 
click on Begin Processing.  

 
After the selection process has been completed, the user can either select Print List (generates a listing of 
the currently selected customers) or after selecting a document template, Print Letters (creates the template 
document for all customers selected). 
 

Template Maintenance Screen  
 

 
This screen allows the user to setup different Word and email document templates to be used with the Collections 
Manager module. The Target field defines the available fields for bookmarking. The Template Path defines the 
location of the template document.  For information on how to setup bookmarks in Word or email, please refer to the 
Word and email user guides.  Some excerpts from the MS Word help menu for adding or showing bookmarks in 
Word are list below:   Once bookmark ID’s are setup, the user can then map the bookmark to the appropriate 
Solomon Collections Manager data field.  When the document template is selected, the information for the specific 
Customer will be populated in the Word or email Document.  

 
1 Show bookmarks  On the MS Word Tools menu, click Options, and then click the View tab.  Select 

the Bookmarks check box.  If you assigned a bookmark to an item, the bookmark appears in 
brackets ([…]) on the screen. If you assigned a bookmark to a location, the bookmark appears as 
an I-beam.   
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2 Add a bookmark  A bookmark identifies a location or selection of text that you name and identify 

for future reference. For example, you might use a bookmark to identify text that you want to revise 
at a later time. Instead of scrolling through the document to locate the text, you can go to it by 
using the Bookmark dialog box. Select an item you want a bookmark assigned to, or click where 
you want to insert a bookmark.  On the Insert menu, click Bookmark.  Under Bookmark name, type 
or select a name.  Bookmark names must begin with a letter and can contain numbers.  You can't 
include spaces in a bookmark name. However, you can use the underscore character to separate 
words — for example, "First_heading."  

The Dunning Letter Template.dot is a Microsoft Word template that can be used to generate the Dunning 
Letters.  During the installation process, the file is installed to Solomon\SSYH\AR Collections. You can copy 
this file to to the User Templates directory (as defined in the Options screen under the Tools section or 
Microsoft Word).  Since the template can be stored in the User directory, it is possible to have it customized 
to reflect user-specific requirements. 
 

AR Collections Manager Reports 
The SSYH AR Collections® module contains three basic reports.  Each report is placed in the Microsoft 
Dynamics™ SL root folder.   

User Customer List Report 
This report is a simple listing of all customers and 
their assigned representative.  The report, sorted 
by UserID then CustID, has three columns:  
UserID, CustID and CustName.  As with any 
Microsoft Dynamics™ SL Crystal Report ®, the 
user can either export to any number of formats, 
print to file or print to a printer. 
 
 
 
 
 
 
 
 

 
 
 

Dunning Letter List Report 
This report lists all the customers 
currently selected for receiving a 
Dunning Letter.  The report, sorted by 
CustID, has three columns:  Customer ID, 
Name and Attention.  The report can 
either export to any number of formats, 
print to file or print to a printer. 
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Collectors Notes Report 
This report, by default, will display all notes for all customers.  The information is in date order (date note 
entered)...  Using the Select tab will allow you to limit the information returned (i.e. selecting only one 
customer id, etc.).   

 
 
 
 


